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Background 
This paper results from a desire by the author, having read up on the complexities of colour 
management in the world of electronic photography, to prove to himself that colour 
management was working well in his system. Although having a basic background in colour 
reproduction there were aspects of ‘colour management’ which seemed to be over 
complicated, when it appeared that often all that was required was to set up the system 
correctly. That is not to demean ‘to set up the system correctly’; the almost limitless number 
of menu choices offered within a system can lead even the conscientious photographer into 
making incorrect combinations of selections. 
 
The approach was firstly to consider each stage in the overall system from scene to print in 
terms of colour reproduction theory and identify where fundamental limitations might occur. 
Then to follow up with an analysis of the workflow to ensure that through the complexities of 
setting up the camera, the computer, the various computer applications, the screen and the 
printer, a consistent approach to developing a working procedure was adopted. 
 
In undertaking this work it became evident that there were many stages along the path where 
it was all to easy to make the wrong decision in selecting options of setup, so much so that 
colleagues aware of the project, considered that the experience gained would benefit a wider 
circle of those interested in getting good colour reproduction out of their system.  
 
This resulting paper, which is effectively a cleaned up description of the work undertaken to 
prove that the author’s system was working well from a colour management perspective, is 
split into two parts. The first part reviews briefly the fundamentals of colour reproduction as 
they apply to a typical system and identifies the reasons why there may be discrepancies 
between the scene, the displayed image and the print; even in a system as good as current 
technology and practices will allow. The second part concentrates on guiding the user through 
the maze of colour related options which are available through each stage of the workflow 
from scene to print. 
 
The result is a somewhat more extensive paper than initially envisaged and that is a pity. It is 
suggested therefore that since most of the problems the author has identified relate to the 
incorrect selection of options in the day to day operations, then, if the main purpose of reading 
this paper is primarily to sort out one’s own system, the reader may omit Section 2 without 
detracting very much from the main theme of the paper . 
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1.  Setting the Scene 
In the above, mention is frequently made of the ‘system’, ‘workflow’ and ‘proof’, thus in 
order to put the project into context we need to be sure of what we mean by these fundamental 
elements. 
 
The System and Workflow 
The system comprises all those elements in the workflow between the original scene and the 
final printed image. My colleague Ray Knight has produced a workflow diagram which 
provides a very useful reference for this work, a slight variation of which appears below. 
 
Rather than describe the elements of the workflow in detail at this stage, it is suggested 
instead the reader takes a high level review of the overall system. Elements of the diagram 
will be reproduced later in the document where appropriate. 
 
As can be seen from the diagram it is assumed that Photoshop will be the application of 
choice for processing the photographic image. 
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The Proof 
The first job was to define the criteria of proof that the system was working well and these 
were: 
 

1. The scene and system monitor display produce a good visual match and 
2. ideally, both the 
 

 system monitor display and print are a good visual match and 
 the print displays a good match to the original scene. 

 
The Match 
Having defined the proof in terms of matching criteria we need also to elaborate on what we 
mean by a match. 
 

 For the purposes of this exercise the match is defined as the closest subjective 
colourimetric match – albeit that in a working photographic environment it is often 
desirable to move away from this objective aim. 

 
However if a good colorimetric matching environment is the norm, it is much easier to then 
make the subjective adjustments to achieve the desired results. 
 
Causes of Mismatch 
Our approach will be to identify where possible, possible causes of mismatch and to then 
review how they each are likely to affect the colour management process. 
 
There are two principal causes of mismatch: 

 Fundamentals 
o Failure of equipment fundamentally to meet the design criteria for a colour 

reproduction system. 
 Operations 

o Failure to provide in the workflow the environment required to ensure that 
colour matching is achieved because of errors in setup and adjustment. 

 
There isn’t a lot we can do about the first category other than understanding and identifying 
these errors but many of the problems occur in the second, operational category and these can 
be addressed by applying appropriate procedures.  
 
Colour Measurement 
It will be seen that most of the items in these categories relate in one way or another to the 
fundamental colour characteristics of the system and although it would not be appropriate in 
this paper to sidetrack into colour measurement it is worthwhile highlighting two of the 
fundamentals as they apply to colour reproduction. 

 Colour Fundamentals 
 For every set of primaries, a set of unique analysis characteristics may be 

calculated. Thus there is a fixed relationship between a set of primaries and the 
system analysis characteristics which are required to match them. Together they 
comprise a unique set. 
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 The primaries define a colour space which may be processed by matrix algebra to 
any other colour space, defined by a different set of primaries and a corresponding 
different set of analysis characteristics. 

 
Thus it is critical that the display primaries are driven with signals which appear to have been 
derived from a source with matching analysis characteristics. The practical implications of the 
second statement is that, subject to no technological limitations, signals derived from one set 
of analyses characteristics may be matrixed to another set which are matched to a different set 
of primaries. As we shall see, this technique is used frequently in colour reproduction 
systems. 
 
Should the reader wish to delve deeper into the background supporting these statements he or 
she is referred to ‘Colour in Electronic Image Reproduction’ by the author which will be 
available shortly or any of the excellent books available on the topic. 
 
Colour Spaces in Photography 
Since we shall be referring to them frequently, we will briefly review the characteristics of the 
colour spaces in common use in photography using the CIE Nearly Uniform 1976 
Chromaticity Diagram. 
 

 
 

The outline of the irregular shaped triangle shows the spectrum locus of all spectrum colours 
perceived by the eye from a wavelength of 400nm through to 700nm. Since any additive 
mixture of two colours falls on a straight line between the colours on the diagram then this 
triangle incorporates all colours. 
 
Any three primary colours may be plotted on the diagram and the gamut of colours they are 
capable of displaying becomes a triangle connecting the three primaries together. Thus within 
certain constraints the larger is the primaries triangle the larger the gamut of colours the 
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primaries can embrace. However this theoretical ideal has to be tempered by the availability 
of primaries with the required chromaticities. 
 
The three colour spaces most frequently used in photography are sRGB, Adobe RGB and 
ProPhoto RGB and their primaries and the colour gamuts they embrace are shown on the 
diagram. It will be noted that ProPhoto uses an ‘imaginary’ blue primary in order to embrace 
a greater gamut. 
 
What is  critical is whether the gamut covered by the primaries incorporates the majority of 
the colours which appear in the scene. Michael Pointer’s work1 to establish the gamut of real 
surface colours is also shown on the diagram in order that comparisons may be made between 
the range of colours in the scene and what can be accommodated within the reproduction 
system. 
 
2.  Causes of Mismatch – Fundamentals 
The principal failures of equipment fundamentally to meet the design criteria for colour 
matching may be listed as follows: 
 

o Imperfect camera colour response 
o The interface between the camera and Photoshop 
o Colours in scene outside the gamut of system display 
o Colours in scene outside the gamut of printer 
o Gamma laws of camera, display or printer do not follow power law curves or 

do not match each other over the viewable dynamic range. 
 
We will briefly describe these fundamental deviations from the ideal in order that we can be 
aware of their existence, albeit that very little can be done to correct them but before doing so 
we will review the workflow stages in the camera. 
 
The workflow of a camera is illustrated below with the functionality of the more 
professionally orientated versions, including the raw output option, shown. 
 

 
 
                                                 
1 The Gamut of Real Surface Colours. M. R. Pointer Color Research and Application. John Wiley and Sons 

©Michael Tooms 2007/2008  Page 6 of 50 



For simplicity the single transducer usually found in a photographic camera is shown as three 
separate sensors in order that the colour response of the individual red, green and blue 
elements of the optical system can be clearly seen. The summation of the effect of the filters 
and the sensor is to provide analysis characteristics which effectively describe the ‘native’ 
colour space of the optics of the camera.  
 
Following ISO gain and digitisation the output is made available as a raw file, that is a file 
which has not been processed to provide the red, green and blue signals which are recognised 
by standard computer applications such as Windows Picture and Fax  Viewer and Photoshop. 
It is considered that by having access to these raw files they may be processed externally by 
special computer applications in a manner which is superior to that provided by the camera 
manufacturer who cannot provide for fine adjustments on each photo taken. 
 
The raw signals in the camera are also passed to the demosaicing circuits and then on to the 
in-camera processing system which, as shown, passes the signals through a number of 
processing stages. One of these stages matrixes the native RGB signals to either the 
AdobeRGB or sRGB colour space, as set by the camera settings. An ICC profile is then added 
to the file which incorporates the specification of the selected colour space to indicate to 
future stages of the system which colour space the signals relate to.   
 
2.1 Imperfect Camera Colour Response 
It can be shown that for a camera to be able to respond appropriately to a wide gamut of 
colours with reasonable efficiency and colour accuracy it should have native taking 
characteristics which match reasonably closely a set of analysis characteristics similar to those 
illustrated below. 
 

 

 
 
The negative lobes of the curves may be simulated by using a matrix to take a percentage of 
the inverse positive lobes of an appropriate different colour. The diagram over the page shows 
the best that can be achieved by this technique. 
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Thus in an ideal situation the native colour space of the camera would be characterised by the 
matrixed curves shown in the above figure. Such a camera would still produce some 
mismatches caused by the lack of a strict match to the ideal curves but the results would be 
regarded as satisfactory for all but the most critical of viewers. 
 
However in reality, the practicality of producing the colour separation process, the elements 
of which include the lens, the colour filters and the colour response of the transducer(s), is 
such that  a match to these curves is likely to be unattainable. Manufacturers do not publish 
their native taking characteristics but measurements by independent bodies indicate 
significant departures from the ideal shown here. 
 
2.2  The Interface Between the Camera and Photoshop 
The camera contains circuitry which matrixes the signals derived by the native gamut to one 
of usually two recognised colour spaces, sRGB or AdobeRGB, for storing as a file. These 
files are then passed to the computer for processing, display and printing. However as can be 
seen from the two sets of analysis curves illustrated over the page, for these output gamuts 
there are segments of the spectrum where for saturated colours the red, green or blue signals 
could be negative and the current file structures do not accommodate negative signals. Thus 
any negative signals will be clipped by the camera circuitry and it can be seen this is more 
likely to occur and be more serious for the sRGB selection than for AdobeRGB; the effect 
being to lose saturation and detail in these particular areas of the reproduced image. 
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The exception is the RAW file option which is available on the more professional and 
prosumer cameras. Here the native gamut signals, potentially with their relatively minor 
negative lobes, are stored directly into a file which can accommodate them. These files are 
then opened in a RAW file viewer which enables the user to adjust the image for the best 
results. Once adjustments are complete a working colour space profile is selected for 
attaching to the file for transfer to Photoshop.  The selections available are sRGB, 
AdobeRGB, or the less limiting ProPhoto colour space.  
 
We have seen that transferring from the camera native gamut to either sRGB, or to a lesser 
extent AdobeRGB working spaces, will lead to inevitable errors in handling the RGB signals. 
However an inspection of the ProPhoto gamut shows that it fully embraces the gamut of real 
surface colours, thus if this working space is selected when transferring from the raw file 
converter, the file will be passed to Photoshop without impairment. We will assume that this 
option is selected and ignore for the moment the other pros and cons of using raw files and 
large working colour spaces. 
 
2.3   Colours in Scenes Outside the System Display Gamut 
The system display gamut is defined by the display chromaticities which at the current time 
are generally defined by the sRGB primaries, a standard which itself is intended to represent 
the average best of CRT and plasma screen phosphors. 
 
The CIE 1976 nearly uniform chromaticity diagram over the page illustrates approximately 
the gamut of real surface colours as established by Michael Pointer and the gamut of the 
sRGB display colour space. 
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Even if we assume the possibility of perfect camera responses and a file format and a 
computer application capable of accommodating fully saturated surface colours, nevertheless 
our display based upon the sRGB gamut will not be able to accurately reproduce those 
colours appearing outside of the display gamut and, as you can see, this represents a not 
insignificant range of surface colours. 
 
Thus the limitation of current displays are one of the major reasons for being unable to match 
saturated colours in the scene with the those on the display. 
 
However the sRGB gamut is as it is because it is the standard based upon the best real 
phosphors available for cathode ray tubes and plasma displays. Generally speaking LCD 
displays, which use filtered white light as their primaries, are hard pushed to match the 
saturation of even the sRGB primaries. 
 
New, relatively expensive, LCD displays are becoming available (2007) with LED light 
sources and these are claimed to be able to match the AdobeRGB primaries. This is a distinct 
improvement but by no means a completely satisfactory solution as can be seen in the 
illustration above comparing the AdobeRGB and the Pointer Surface Colours gamuts. 
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Falling back once more on our workflow diagram we can see that Photoshop passes the signal 
via the ‘Proof Colours’ switch, seen here in the off position, to the computer operating system 
where the  signal is converted to the display colour space and processed by Adobe Gamma 
before being fed to the display. 
 
2.4 Colours in Scenes Outside the Printer Gamut 
The above workflow diagram also shows the printing paths. The signal with the Photoshop 
working colour space is effectively fed to the printer profile where it is converted into the 
printer colour space to match the inks and the paper and then fed to the printer via the 
‘Document’>’Proof’ switch. 
 
As with the display, the printer in unable to provide a gamut which embraces the complete 
range of surface colours. 
 
Obtaining the colour gamut of a printer is not as straightforward as it is for a monitor display. 
The colour gamut is dependent upon the printer, the inks or pigments and the paper. Also the 
gamut tends to vary considerably with the range of lightness of the inks or pigments 
deposited.  
 
I was unable to find a direct set of data relating to the printer gamut but found on the web, on 
the ‘Gamut Vision’ site, which I can recommend, a good representation of what purports to be 
the gamut of the Epson R2400 printer, which is pretty representative of being amongst the 
best desk-top printers available. The sRGB and the surface colour gamuts have been added. 
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The diagram shows a number of interesting points. Despite the limitations of the system 
display, only a very small percentage of the print gamut, i.e. in the cyan and the yellow to 
orange area, is not within the sRGB gamut and all the printing gamut is well within the 
AdobeRGB gamut. Comparing the real surface gamut with the printing gamut shows large 
areas virtually all round the gamut which are missed by the printer, in terms of saturated 
colours, only the yellow to orange colours are closely matched. 
 
It must be remembered that colour is three dimensional and that in addition to the hue and 
saturation, the lightness is also critical in matching the original scene. One of the common 
problems found in matching prints to scene or monitor, is that the gamma laws of the camera, 
the display and the printer, either or both do not accurately follow power law curves or match 
each other over the viewable dynamic range.  
 
There is virtually nothing we can do about this as even with advancing chemistry there will 
always be a relatively limited printing gamut when compared to the real surface colours 
gamut. However luckily, in the average scene, the vast majority of colours will fall within the 
printer gamut and it is our job to ensure they are reproduced satisfactorily. 
 
2.5  Gamma 
Current image sensors are linear over their usable range but traditionally a power or gamma 
law function is applied to the signals in the camera at some stage after matrixing to the 
working colour space. It should be noted that matrixing must be carried out on linear signals. 
The gamma or power law applied is notionally the inverse of the CRT display characteristic 
which is generally regarded to be about 2.5. However because of the limited contrast range 
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available to display devices and prints, experiment has shown that rather than produce an 
overall transfer characteristic with a gamma value of 1, i.e. linear, a value in the range of 1.1 
to 1.25, depending upon the available contrast range of the print is preferred. 
 
Thus the workflow transfer characteristics will be non-linear in some stages of the workflow 
fundamentally for two reasons: 
 

• Because the response of the eye is non-linear and applying a power or gamma law to 
the signal can provide advantages in the utilisation of the dynamic range available. 

 
• Because historically CRT display devices have had a power law transfer characteristic. 

 
Mathematically the inverse power law has an increasing gain with lowering signal level, 
being infinite at zero input. Such a law is impractical technologically and this is recognized by 
the sRGB colour space which limits the gain of the power law to about 13 at low input levels. 
However the AdobeRGB colour space does not have a specified limit, therefore the limit set 
is open to interpretation.   
 
The signals which are gamma corrected in the camera are de-gammed by Photoshop for 
colour processing and re-gammed for display and printing. In the event that these curves are 
not fully matched there is an opportunity for a mismatch to be exhibited in the display and or 
print. 
 
3.  Setting The Scene for the Operational Tests 
In operational terms we originally defined the causes of mismatches between scene, display 
and print as follows: 

 
• Failure to provide in the workflow, the environment required to ensure that colour 

matching is achieved because of errors in setup and adjustment. 
 
The principal causes of poor matching in the operational environment are as follows:  
 

• A poor viewing environment for the matching process. 
• A poorly set up system monitor display. 
• A poor gamma match between camera and display. 
• A poor gamma match between display and printer. 
• Incorrect settings within Photoshop. 
• Incorrect settings within the printer driver. 
• Inappropriate printer paper for the match 

 
Unlike the fundamental problems reviewed in Section 2, we can do something about 
operational problems but in order to do so as thoroughly as possible we need to have available 
a range of ‘tools’ to assist in ensuring the system is setup correctly and can be monitored to 
confirm that it is so. 
 
The system used was comprised of the following equipment: 
 

• Minolta Dimage A1 Camera 
• Casio Exilim EX-Z40 Camera 
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• Epson Perfection 1200S Scanner 
• Computer with XPPro & Photoshop CS & CS3 
• Screen, Eizo 20” Type L885 
• Printers: 

o Epson Stylus Photo EX 
o Epson Stylus Photo 1800  

• Photographic quality neutral white print paper  
 
And the tools required to check out the system were:  
 

• Gretag Macbeth ColourChecker Colour Rendition Chart, evenly illuminated, 
ideally outdoors in lightly overcast sky, 

• An electronic grey scale test chart, 
• Monitor screen and adjacent viewing area illuminated by D65 for test charts and 

prints.  
 
The neutrality of the print paper is emphasized because if we are to match the Gretag test 
chart then clearly the white of the chart and the print paper must match. 
 
These tools are illustrated in the following figures. 
 

 
 

The GretagMacbeth Colour Rendition Chart 
 
 
It is the white chip on this chart which the white of our print paper will need to match and 
which of course cannot be modified in colour or lightness in any way since no pigments are 
deposited at white. The paper used for this test was Hahnemule Photo Rag 308 g/sq m and it 
provided an excellent match to the GretagMacbeth colour chart white. 
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The Electronically Generated Greyscale 
 
 
The figure illustrates the electronically produced greyscale which is used to check that the 
system monitor is correctly setup. All steps on the scale should appear the same neutral grey 
and match the greyscale of the test chart placed adjacent to the monitor and appropriately 
illuminated. The scale has ten values, the value between each step producing a subjectively 
equal lightness step in a display with an accurate power law characteristic. 
 
At each end of the grey scale two further chips with only small changes in lightness are 
incorporated to ensure that there is no crushing of the dynamic range. On the chart illustrated 
these minor steps are set at about 3% and 7% away from black and white respectively. (that is 
at 8 and 18 code levels respectively.) The scale is comprised of linear steps in electronic terms 
so the display device with its gamma law transfer characteristic will effectively greatly reduce 
the gain near black level making the setting of the black point very critical. In a well lighted 
environment one should just see the last black or white end chip, which is unlikely to be seen 
in this printed document.  
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A Wide Angle Shot of the Viewing Area for Comparing the Matches 
 
What do we mean by a well lighted environment? The figure above illustrates a long shot of 
the viewing area which requires a few words of explanation. The illumination of the print area 
at the rear is by D65 florescent lamps masked by the two vertical strips either side of the 
monitor. These lamps are under dimmer control in order that the peak white of the print can 
be matched by the peak white of the display. Nearly neutral grey card is used as the 
background to the viewing area in order that the eye accommodates to the illuminant colour. 
A D65 florescent down light illuminates the keyboard area but the monitor is shielded by an 
overhanging shelf. The remainder of the room is darkened for critical viewing. 
 

 
 

The Viewing Area From the Critical Seat 
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When seated in the working position, as the illustration at the bottom of the previous page 
shows, most of the field of view is taken up with neutral areas illuminated by the standard 
illuminant which assists in ensuring the eye is fully accommodated to the white point hue of 
D65 and is therefore at its most critical when assessing colour differences.  
 
Colour Spaces and Their Conversion 
The colour spaces contained within Photoshop may be considered as follows: 
 

• The Adobe Colour Engine (ACE) Workspace (not available to the user). 
 

• The chosen default workspace. 
 

• The workspaces for individual images, where the original non-default profile is 
retained. 

 
In the context of a colour management system, Photoshop provides a large number of colour 
spaces to work with from what might loosely be described as system workspaces through to 
workspaces designated for specific requirements, such as the display profiles, the printer 
profiles and the printing paper profiles. Unfortunately at every point in the workflow where a 
profile may be selected all possible profiles are presented for choice, irrespective of the fact 
that in many cases the majority of those presented are inappropriate for the purpose at that 
point in the workflow. This can be confusing to the uninitiated. 
 
Thus Photoshop provides for the selection of workspaces throughout the workflow, from the 
loading of the image file, through the working space to the print space, and, optionally via the 
soft proofing space, back to the working space and the viewing space. The conversion from 
one working space to another requires a lot of calculation. Each of the RGB signals must be 
de-gammed, matrixed to XYZ colour space, matrixed to the new colour space and then re-
gammed. Photoshop undertakes these tasks transparently, though there are limitations to look 
out for which we will address later. 
 
The principal aim of the project was to identify these spaces and profile conversion activities 
in terms of where they could be accessed in the menu system and to use the captured image 
files to see the effects of various menu selections on the images. 
 
Aims of Tests 
In essence the aim of the tests are: 
 

• to capture the GretagMacbeth colour chart image using a range of colour settings 
on the camera and scanner and store these images in different file formats and 

 
• to use the various captured file images to explore and exercise what is happening 

using different settings within Photoshop and thus establish conclusively the 
correct settings for a typical workflow. 
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In what follows, a logical approach is taken to setting up the system in a colour management 
environment, starting with the equipment and operating system and then moving on into 
Photoshop itself. Where appropriate at each stage the effect of changing a parameter is 
evaluated using a range of the pre-captured image files, the contents of which have parameters 
designed to exercise the various options within Photoshop. 
 
In order to appreciate what is happening as one loads image files into Photoshop, images 
which have been derived at capture using different colour spaces and with and without 
different embedded profiles, it is essential to have a range of appropriate image files available. 
These files should ideally contain an identical critical grey scale and a range of colour 
samples which will readily show any differences in display as different parameters are 
selected in Photoshop.  
 
Once the loading options have been clarified and the displayed images have been reviewed, 
attention is then turned to the printing options and the review of the final prints. 
 
4. The Operational Tests 
4.1 Image Files 

4.1.1  File Formats 
These are the file formats generally available to the image capture devices. 
 

• RAW Files. Uncompressed and unprocessed 12 -16 bit images, in the camera 
native colour space. 

• TIFF Files. Files with no compression artifacts stored at maximum resolution with 
a bit depth of 8 bits, usually in sRGB or AdobeRGB colour space. 

• JPEG Files. Files with optional selectable degrees of compression, 8 bits and 
selectable sRGB or AdobeRGB format. 

 
Camera image files are usually made available either in JPEG format with various 
compression quality options or, in professional and prosumer models, alternatively as TIFF 
and RAW files. The raw camera data is available at bit levels in excess of the eight bits used 
for JPEG and is recorded directly into the raw file with minimal processing. The RAW file 
format is regarded as the highest quality available and results in comparatively very large files 
which will require further processing before they are acceptable to Photoshop or other similar 
applications. 
 
Image capture equipment often provides the option of selecting the colour space into which 
the native RGB signals are matrixed before being saved to the image file; the selection of a 
particular ‘colour mode’, describing the primaries of the working colour space of the mode 
selected.  
 
For non RAW files, the colour mode selected may be recorded within the metadata of the 
image file and also more formally in the form of an embedded ICC defined profile. 
Furthermore, since the photographic industry has made the assumption that the captured 
images will be presented to the viewer on non-linear, CRT based displays; all capture 
equipment includes gamma correction processing to compensate for this non-linearity. For 
colour management to be effective, as signals are processed and re-processed through the 
workflow between image capture, electronic display and print, it is essential that the transfer 
law of the gamma corrector used at capture is accurately known to each process. To this end a 
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number of colour spaces have been internationally agreed which encompass both the colour 
gamut and the transfer law of the gamma corrector. In electronic photography the ‘sRGB’ 
colour space has become the default space for consumer cameras, whilst the more expensive 
models also offer the option of AdobeRGB colour space. Both of these colour spaces are fully 
defined in terms of the display colour primaries and the transfer law.  
 
Currently RAW files, which are not capable of embedding ICC profiles, are formatted to 
proprietary standards set by the camera manufacturer. Nevertheless some time ago Adobe 
proposed an open raw file standard, contained in their ‘Digital Negative (DNG) 
Specification’, which provides an insight into the manner in which data is processed and 
stored in proprietary files.  To complement the specification and to encourage the use of this 
format, particularly for archiving raw files, Adobe provides a free downloadable raw file 
converter which will convert the vast majority of proprietary raw files in current use to the 
DNG format. It would appear that the chromaticity coordinates required to convert the camera 
native colour gamut to the CIE XYZ colour space are contained in proprietary tags within the 
raw file.  
 
We have seen that transferring from the camera native gamut to either sRGB, or to a lesser 
extent AdobeRGB working spaces, will lead to inevitable errors in handling the RGB signals. 
However an inspection of the ProPhoto gamut shows that it fully embraces the gamut of real 
surface colours, thus if this working space is selected when transferring from the raw file 
converter, the file will be passed to Photoshop without impairment to these colours. We will 
assume that this option is selected and ignore for the moment the other pros and cons of using 
raw files and large working colour spaces. 
 
4.1.2 Image Capture 

Workflow - Image Capture 
All image files captured were based upon the GretagMacbeth Colour Rendition Chart, which 
in terms of those shot by the cameras, were initially captured outside on an overcast day with 
no cloud patterns present. However recent work has indicated the viewing environment 
described above is also excellent for image capture.  Both cameras were manually white 
balanced on the white square of the chart but nevertheless prior to correction, images showed 
small but significant colour balance errors. The Minolta camera has options to capture images 
in a number of qualities and colour modes; though not all colour modes are available in all 
quality modes and not all colour modes carry an embedded profile. The modes which implied 
a subjective adjustment by the manufacturer were not used. The Casio camera provides only 
files with dedicated sRGB profiles embedded. The Epson scanner provides the option to 
select colour management capture with a range of ‘target’ colour spaces, however in saving 
the files to jpeg format no profiles are embedded. This apparently negative feature, as we shall 
see, turned out to be extremely useful in exercising the options of Photoshop. For ease of use 
all files were renamed in a manner which described their source and capture characteristics. 
The images captured and their characteristics are listed in the following table. 
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Capture Quality Characteristic Profiled File Type 
Minolta Camera Extra Fine Natural sRGB sRGB .JPG 

  AdobeRGB Untagged .JPG 
  Embedded AdobeRGB AdobeRGB .JPE 
 RAW Natural sRGB Untagged .MRW 
  AdobeRGB Untagged .MRW 

Casio Camera  sRGB sRGB .JPG 
Epson Scanner 400dpi sRGB Untagged .JPG 

  AdobeRGB Untagged .JPG 
  Wide Gamut RGB Untagged .JPG 

 
Table of File Images Captured to Exercise the Operating System and Photoshop 

 
As the project progressed it was established that the image capture options of the Minolta 
camera appeared somewhat anomalous, a situation which was not satisfactorily resolved 
despite significant discussion and correspondence with the UK office and consideration was 
given to removing the offending cases from this chart to avoid confusion. On the other hand it 
seemed likely that other manufacturers’ cameras of similar vintage may have similar 
problems so it was worth highlighting this potentially confusing situation. 
 
In particular, the AdobeRGB setting for the JPEG file did not include a profile and in order to 
avoid ambiguity was not used in the following tests. Furthermore although the camera menu 
settings implied one could set the profile for RAW files this is counter to the philosophy of 
raw file provision which is of course that the electronic image is not processed, and anyway a 
profile is not attached to raw files. In fact experiment showed that irrespective of the colour 
mode setting the results in the raw files were unaffected. 
 
 
4.1.3 Image Preview 

Workflow - Image Preview 
Image preview covers the following viewing options: 

• Windows Picture & Fax Viewer, the 
 

• Adobe RAW File Viewer and the 
 

• Minolta RAW File Viewer 
 
Prior to opening in Photoshop, the images from the JPEG files were inspected in some detail 
using the Windows Viewer, this was in order to appraise the differences in their displayed 
characteristics without the complicating influence of the colour management processes of 
Photoshop.  Images from the same capture source exhibited significant differences, with, as 
expected, the primarily difference being the reduction in displayed saturation as the area of 
the capture colour gamut is increased. No significant differences in grey scale were perceived, 
possibly indicating the same gamma law correction had been applied during image capture, 
irrespective of the colour mode chosen. (One might have expected the difference in the 
gamma law for the sRGB and AdobeRGB colour spaces to show up slight differences in the 
dark steps of the grey scale.)  
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Most camera manufacturers provide their own application for viewing and processing RAW 
files from their cameras and outputting them in a format readable to Photoshop. Versions of 
Photoshop from CS onwards also include a RAW file viewer as a plug-in which will read raw 
files from most common cameras and export them in a format compatible with Photoshop 
itself. 
 
With regard to the RAW file viewers, both the proprietary and the Adobe raw file viewers are 
able to matrix the raw signals to the XYZ colour space on entry into the viewer. Since the 
viewer provides an accurate display of the image, there is clearly also a conversion process to 
the screen colour space for viewing purposes. The output from the viewer may be saved to a 
number of formats recognised by Photoshop and, depending upon the viewer, the defined 
output colour space may be selected from a number of options and a corresponding profile 
embedded in the output file. The Adobe raw file viewer provides the option of four colour 
spaces; sRGB, AdobeRGB, Kodak ProPhoto RGB and ColorMatch RGB. The Minolta RAW 
file scenario is ambiguous; in the camera, either the sRGB or the AdobeRGB colour gamut 
may be selected but when the file is loaded into the Dimage viewer and saved, no colour 
space option is provided and the file is saved with an sRGB embedded profile by default – 
irrespective of the capture colour gamut. Consequently the Minolta raw file converter was not 
used subsequently. 
 
4.2 Colour Spaces and Their Conversion 

4.2.1. The Viewing Space 
 Colour management is actually shared between Windows and Photoshop with Windows 
being responsible for the viewing colour space, which is of course defined by the chromaticity 
coordinates of the monitor display primaries and the gamma ‘correction’ applied. Generically 
the sRGB primaries are intended to represent a set of typical current display primaries and in 
the absence of a dedicated monitor profile, Windows will supply this profile to the monitor 
signal path. Manufacturers of quality displays provide a profile file (that is a .icm file) which 
accurately describes the chromaticities of their particular display primaries. Traditional LCD 
displays, illuminated by a white back light, find difficulty in matching the saturation of the 
sRGB primaries, whilst those LCD displays utilising LEDs as their light source are able to 
provide primaries of significantly wider gamut, including the claimed ability to match the 
AdobeRGB primaries. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

©Michael Tooms 2007/2008  Page 21 of 50 



 
 
4.2.1.1 The Display Profile  

Workflow – Image Display - The Display Profile 

 

 

 
 
 
The display profile is stored in: 
 

Windows>system32>spool>drivers
>color 
 

Profile selection screen can be accessed 
by: 
 

Control Panel>Display> 
Settings>Advanced> 
Color Management> 
Add>Set as Default 

 

 
The display profile file is usually loaded at the time the display screen is installed and is 
stored along with all the other profile files used by both Windows and Photoshop in the 
directory shown above. Using Windows Control Panel the viewing profile selection screen 
can be accessed, where it is likely that any previously loaded profile will appear in the list of 
profiles currently associated with this device. Should a dedicated profile not be available, the 
sRGB profile can be loaded from the pool of profiles using the ‘Add’ button to display the list 
of available profiles for selection. 
 
In this case the Eizo screen is provided with the monitor L885 profile and this has been 
installed. An explanation of the use of the dated profile follows shortly. 
 
 

4.2.1.2. Display Profile Adjustments.  
The ‘Adobe Gamma’ feature provides the opportunity to check and if necessary carry out 
minor adjustments to the display profile which controls the display of images on the monitor. 
This critical feature may be accessed as shown on the next page and loads as a default the 
working display profile as set by the previous procedure. Other profiles may be loaded but if 
saved they will of course replace the previously selected working display profile.  
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The complementary application to the ‘Adobe Gamma’ setup program is the ‘Adobe Loader’ 
which is deposited in the directory shown when Photoshop is installed. It is important to 
check that this application is resident in the above directory since it is responsible for loading 
any amended gamma characteristics each time Windows loads. If it is not there Windows 
loads a default set of gamma parameters. 

 
 
 
 
 
 
Accessed by menu: 

Control Panel> 
Adobe Gamma 

 
Adobe Loader stored in: 

All Users>Startup 
 

 
Adobe Gamma may be used to make minor gamma adjustments to the matching monitor 
profile to suit a particular application; typically very minor adjustments to both make a 
change in the overall gamma to correctly display the dynamic range or, if really necessary, the 
individual gamma values to neutralise the grey scale. 
 
The default gamma does not appear to be related to the profile selected but to the Windows 
default of 2.2  
 
4.2.1.2.1 Setting the Gamma Value 

I must emphasise that often the grey scale will be displayed satisfactorily and if the monitor 
has been correctly set up then at worst only minor adjustment of Adobe gamma will be 
required. 
 
The neutral electronic grey step chart described previously should be used for setting the 
gamma value in Adobe Gamma settings and should be loaded into Photoshop. If the overall 
system, of computer and monitor, are correctly adjusted the four minor steps should appear 
with equal differentiation between steps. However LCD monitors tend to make the 
differentiation of the dark steps less obvious and even quality LCD monitors will often show 
pronounced differences in differentiation at slightly different viewing angles.   
If there is significant unequal differentiation between the dark and light pair of minor steps, 
then tick both the ‘View single gamma only’ box and the slider to activate the adjustment 
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process. The slider control is too crude to make fine adjustments – use the left and right hand 
arrow keys which make very fine changes for each depression. It is emphasised that this 
adjustment is extremely critical for the correct display of the dynamic range of images.  
 
4.2.1.2.2.  Saving the Gamma Adjustments 
If any changes are made, it is important before saving to amend the ‘Description’ panel since 
this is not the profile file name but is a descriptive title extracted from within the file upon 
loading. If it is not amended in line with the new file name it can cause confusion on loading 
at a later date. Irrespective of whether changes are made or not, care is required when saving 
the result, in order to ensure that the master display profile supplied by the screen 
manufacturer is not overwritten by what is now a custom profile. One approach is to add the 
current date to the working screen profile name in the Description panel before saving, as 
shown in the illustration on the previous page. 
 
4.2.2 Photoshop – Working Space 
The approach adopted by Photoshop to managing colour spaces operates at two levels. At the 
top level one may set the generic working colour spaces for both RGB and CMYK, these 
being the spaces Photoshop will assume you generally wish to work in; at the secondary level 
one may assign or change the colour space of a particular image independently of the generic 
working space selected at the top level. 
 
The Photoshop working space is the default space into which image files are loaded. The 
particular options underlying the generic RGB>CMYK spaces described above may be 
accessed for selection via the menu as illustrated over the page, where the resulting panel will 
also show all the other options relating to the use or otherwise of the various parameters 
associated with the colour management system.  
 
It will be noted that at the top of the ‘Color Settings’ panel is the ‘Settings’ selection which 
in the CS version gives over 20 options of settings, primarily associated with the common 
press standards used in the three dominant printing areas of the world. In the CS3 version 
only the few options associated with the American printing industry are offered, however 
neither version includes an option for desktop printing. When an option is selected, the range 
of other parameters associated with the particular selection are placed in each of the boxes 
within the ‘Working Spaces’ and ‘Colour Management Policies’ areas below.  
 

©Michael Tooms 2007/2008  Page 24 of 50 



 

 
 
 
 
The CS version Colour Settings 
panel. Select via menu: 
 

Edit>Color Settings 
(Shft+Ctrl+k) 

 

 
 
 
In the CS version of Photoshop, Colour Management may be switched off by selecting the 
appropriate item in the ‘Settings’ box at the top of the ‘Color Settings’ page. The CS3 
version does not provide this option. It should be noted that even when switched off, it is still 
necessary for Photoshop to have a working space and in this case it defaults to the ‘viewing’ 
working space described above. As can be seen in the above illustration, this is shown by the 
viewing working space identity appearing in the ‘Working Spaces>RGB’ panel below the 
settings control. When switched off it will also be noted that the parameters in the ‘Color 
Management Policies’ panel are forced to a default Off position with only the ‘Profile 
Mismatches – Ask When Opening’ box ticked. Again only the ‘RGB’ box is of interest in 
this panel. The settings for the ‘Color Management Policies’ panel will be dealt with later. 
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Since in neither the CS or CS3 version of Photoshop is there an appropriate option under 
‘Settings’, we will continue with the other options. In the CS version, the RGB working 
colour space required may be selected from a choice of some 45 or so spaces, including, 
strangely, the various print paper profiles associated with printers connected to the computer. 
Most of these are irrelevant to our requirements and the basis for selecting the working space 
is discussed in ‘Loading Files into Photoshop’ shortly. In CS3 it is good to see only the 
relevant working spaces; sRGB, Adobe RGB, ProPhoto RGB, ColourMatch and Apple RGB 
are provided as optional working spaces. 
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The CS3 version of 
the Color Settings 
Panel 

 
 
To provide us with a colour space which encompasses all the surface colours we will select 
ProPhoto RGB. We will not be using the CMYK working space so we can leave it in its 
default position. The ‘Colour Management Policies’ options should be set as shown in the 
above screen capture. The purpose of these various parameters will become apparent as we 
progress through the workflow. 
 
It will be noted that once any of the parameters in Working Spaces are changed, the ‘Settings’ 
box will change from the default to ‘Custom’. Once it is established that a custom 
configuration will be used on a regular basis it may be saved with a new title for future 
reference. This title may then be selected from the ‘Settings’ box list of options, providing 
with one selection the full range of colour management options required. 
 
4.3. Loading Files into Photoshop 
The action of loading a file into Photoshop effectively places that file into the Photoshop 
working space. This is a straightforward matter if the profile space of the image capture 
system, i.e. camera or scanner, and the working space of Photoshop match, AdobeRGB for 
instance, but if they do not then, depending upon which boxes are ticked in the ‘Colour 
Management Policies’ panel illustrated above, Photoshop presents the user with a number of 
options. These options depend upon:  
 

• Whether color management is activated,  
• The working space selected and  
• The parameters set in the ‘Color Management Policies’ panels, (see screen capture 

above) which control the options presented during loading prior to profile conversion 
when either a profile is not embedded or a mismatch of profiles occurs.   
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In order to understand with confidence the options provided and the actions taken by 
Photoshop when loading files, both with different characteristics and with different options 
selected in the Colour Management Policies panel, it is very useful to have a range of files 
with identical images available but with different capture characteristics. This was one of the 
main reasons the range of files described earlier were captured and they may be used to good 
effect in confirming the options and actions described in the remainder of this section.  
 
In the Settings default scenario, the ‘Colour Management Policies’ panel boxes will appear 
as in the illustration and the loading of files are described in the descriptions to follow. As 
long as the appropriate ‘Ask When Opening’ boxes are ticked the setting in the RGB box 
does not influence the display of the option panels which follow. If the RGB box is set to 
‘Convert to Working RGB’ and the appropriate ‘Ask’ box is not ticked then conversion of 
non-matching files to the working space will take place automatically after the first 
conversion, subject to the option panel that first appears being appropriately ticked. 
 
Loading Files 1 - Colour Management Off 
If ‘Colour Management Off’ is selected then as we saw above the working colour space will 
default to the monitor colour space and this dictates the choices offered when an attempt is 
made to load say the Minolta Natural sRGB file, as this screen capture illustrates. 
 

 
 
As with all the various loading option panels, the embedded and the working spaces are 
shown to remind the user of the current situation. In this case the default option is to discard 
the embedded profile and work without colour management. Should a file with no embedded 
profile be loaded in this situation, then Photoshop places it straight into its working space with 
no questions asked. 
 
Loading Files 2 - Colour Management in Operational Mode 
If ‘Settings’ is set to an operational ‘Colour Management’ configuration, and an attempt is 
made to load a file with an embedded profile, which matches the selected working profile, 
then the file will again load with no questions asked. If however there is a mismatch between 
the two environments then Photoshop will present the same panel as the one above but with a 
different default option selected.  
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If one is working simultaneously with a number of files, with different embedded profiles, 
then it makes sense to convert them all to the chosen working space. If however this is a 
single document there is little advantage in either option, subject to the embedded working 
space being within the limits of the working colour space. In these circumstances it may be 
convenient to place the file into effectively a temporary dedicated working space to match the 
embedded profile. In converting a file, the embedded profile is amended to match the working 
space, so care should be taken when saving the file, if one wishes to retain the original file 
with the original embedded profile. 
 
Loading Files 3 - No Embedded Profile – Case 1 
In the event that one attempts to load a file with no embedded profile, Photoshop will produce 
the Missing Profile panel like this: 
 

 
 
 
This presents the user with an interesting range of options. Assuming that colour management 
is on, then it is unlikely that the first option would be selected. Often, as in the case illustrated, 
although there is no embedded profile it is known that the file was created with a specified 
target colour space, in this case Adobe RGB. Since in this case the working space happens to 
match the capture characteristics the second option should be selected, which will result in a 
matching profile being assigned. This profile will be embedded with the file should it 
subsequently be saved. 
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Loading Files 4 - No Embedded Profile – Case 2 
In the event that the file to be loaded has no embedded profile but has a characteristic it is 
known does not match the working colour space then clearly the third option is selected, the 
appropriate profile matching the characteristic is selected and the box is ticked.  
 

 
 

If the ‘and then convert document to working RGB’ box is ticked, the image will be converted 
to the working colour space and a new profile matching the working space will be assigned to 
the file and will be embedded should the file be saved. 
 
4.4. Managing Files Within Photoshop 
Photoshop provides the facility to manage files that have already been loaded into Photoshop 
but which subsequently it becomes necessary to change a file’s characteristics, either by 
changing the working space from RGB to CMYK or assigning or changing a profile. These 
options are accessed differently in the CS and CS3 versions. In the CS version all options may 
be accessed through the menu selection ‘Image>Mode’. In the CS3 version the colour mode 
options also follow the same route as for the CS version but assigning or changing a profile is 
achieved by access to the ‘Edit>Assign Profle’ menu item. The following examples illustrate 
how these commands may be used. 
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The menu selection shown on the screen capture on the previous page offers three generic 
types of working space for the file to operate within; ‘RGB Color’, ‘CMYK Color’ and 
‘Lab Color’, and provides for a mathematical translation between them. The particular RGB 
or CMYK colour provided is that already set under Edit>Colour Settings. Image 
chromaticities which fall within the gamut of all three colour spaces will be displayed 
identically, irrespective of the working space selected but if, as with the colour chart, some 
chromaticities fall outside of the CMYK colour space, then the selection of that space will 
cause a significant reduction in the displayed saturation of the associated colour patch.  
 
This is a permanent loss, switching back to RGB will not restore the original signal levels.  
 
The primary working space of interest to us is the default ‘RGB Color’ space.  
 
The ‘Assign Profile’ and ‘Convert to Profile’ commands may be found at the bottom of the 
Image>Mode drop down menu in the CS version but in the CS3 version these options are 
accessed directly through the Edit menu. The following examples illustrate how these 
commands may be used. 
 
4.4.1 Loading Non-Profiled Files Without Colour Management 
The aim of this example is to show that after non-profiled files have been loaded with no 
identification at load time, they may subsequently be properly identified and profiled and if 
required converted to the system working space. 
 
The best files for this example are the three Epson Scanner files, which have no embedded 
profiles but which were captured whilst targeted for three different colour spaces: sRGB, 
Adobe RGB and Wide Gamut RGB respectively.  
 
For these tests we will first ensure that sRGB is selected as the Photoshop default working 
colour space.  
 
Loading Untagged Files 
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When loading, select the option presented by Photoshop of ‘Leave as is’ for all three files.  
 
 

 
 
 
And this is the result we get – a very instructive display. It will be noted that three very 
different looking images appear in terms of saturation. If ‘Document Profile’ is the selected 
display in the status bar at the bottom of the Photoshop screen then the profile of each of the 
images is ‘Untagged RGB’.  Also in the document’s title bar above each image, a ‘#’ has 
been added to ‘RGB’ (RGB#) to indicate there is no confirmation of a match of the capture 
and the working profiles. 
 
Before progressing further, it may be instructive to discuss why it is that those images 
captured with the larger gamuts are displayed with decreasing saturation. The signal code 
values, in for example the Wide Gamut RGB file, are expecting to control saturated primaries 
and therefore have a lower value than the corresponding numbers in the sRGB file. Since 
however in this display, because there is no profile present to tell Photoshop how to handle 
the file, these lower numbers are controlling sRGB primaries and the result will be a 
desaturated display. 
 
Assigning Profiles 
Using Image>Mode>Assign Profile> or Edit>Assign Profile for CS or CS3 respectively, 
the screen capture illustrated at the top of the next page appears.  
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We can now assign the appropriate matching profile respectively to each of the images in turn 
by highlighting the ‘Profile’ button. As each image is selected one may click alternately on 
the ‘Preview’ box and see the effect of applying the profile to the image. 

 

 
 
The diagram above illustrates the result. It will be noted that the sRGB targeted image does 
not change but the presence of the appropriate profiles causes the other two images to be 
processed such that they now form a perfect match with the sRGB image. Also in the status 
bar, as each image is selected, the matching working space name appears.  
 
Thus although we now have matching images, each is displayed in its assigned working space 
(as opposed to the system working space) and if these files were to be saved, and these new 
files re-opened, it would be found that each now had an embedded profile which matched its 
original targeted colour space. It will also be noted that where the working space does not 
match the system working space the document’s title bar working space indicator has changed 
from RGB# to RGB*. The * indicating a different working space to the current system 
working space. 
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Converting Profiles 
 
Now both of these two non-sRGB image files can be converted into sRGB files by using the 
Image>Mode or Edit menu item respectively for CS and CS3 and the ‘Convert to Profile’ 
command.  
 

 
 

Care should be taken to ensure that the ‘Intent’ option is selected to either ‘Perceptual’ or 
‘Relative Colorimetric’; ‘Absolute Colorimetric’ will seriously distort the white point. 
Photoshop processes the files to the new colour space and edits the associated profile to 
match.  
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And this is the final result. It will be noted that all three images still match one another but in 
the status bar the working space name for each of the images is sRGB, and, if saved at this 
stage, they will be saved with an embedded sRGB profile. It will also be noted that the * has 
been removed from the document’s title bar working space indicator. 
 
4.4.2 Loading Non-Profiled Unidentified Files into the System Colour Space 

Correcting a Mis-loaded Profile 

It is very easy to load a non profiled file into the system colour space as a default – only to 
find that the image clearly was captured with a colour space which does not match the 
working space. Photoshop enables one to correct the situation without having to reload the 
original file. 
 
Let’s assume that the ‘Epson Scanner – Target Wide Gamut’ file has been inadvertently 
loaded into the sRGB system working space where it will now be associated with an sRGB 
profile. The correction procedure is similar to that above; first select ‘Assign Profile’ and 
then select the colour space it is assumed was used as the target colour space during capture – 
in this case the Wide Gamut RGB colour space. Photoshop will now reprocess the image in 
accordance with the new colour space, edit the profile to Wide Gamut RGB and display the 
image correctly in its own Wide Gamut RGB working space. If it is now required to convert 
the image to an sRGB colour space then this may be achieved by selecting ‘Convert to 
Profile’ and then selecting the sRGB colour space. Photoshop re-processes the data to sRGB 
and also edits the associated profile to sRGB. 
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4.4.3 Loading Profiled Files Without Colour Management 

Loading Profiled Files – Colour Management Off 
Although it is difficult to see why one should discard the profile of a profiled file, 
nevertheless should that requirement occur and the file be loaded using the ‘Discard the 
Embedded Profile’ option, Photoshop is able to rescue the situation using very similar 
procedures to those outline above. Briefly, using the Minolta A1 Embedded Adobe RGB file 
as an example: once loaded as described above, use ‘Assign Profile’ to re-assign the 
appropriate profile and then ‘Convert to Profile’ to covert the file to sRGB. 
 
4.4.4  Loading Raw Files 
Raw files are loaded into Photoshop via a raw file converter, which in this case is the Adobe 
‘Camera Raw’ application. See the illustration below for the CS3 version of Photoshop.  The 
raw file carries a good deal of metadata which defines many of the parameter settings of the 
camera at the time the image was captured, including ‘Exposure’, ‘Brightness’ and ‘Contrast’. 
All of these adjustable parameters are made available to the user in Camera Raw. Normally 
‘Brightness’ and ‘Contrast’ are set at the default zero position when the file is opened and 
little adjustment is required; however it has been found that some cameras on some shots will 
set the values of these two parameters at some other relatively high value which gives the 
image a distorted appearance on opening the file.   
   

 
 

The ‘Camera Raw’ Screen 
 
A simple ‘standard’ approach to the adjustment of the image in Camera Raw has been 
established which appears to suit most normally exposed shots and those anomalous shots 
described above: 
 

• Set Brightness to zero 
• Set Contrast to zero 
• Set Exposure to just not clip peak levels on the histogram 
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• If necessary adjust Blacks for best picture – on the GretagMacbeth colour chart this 
setting was adjusted to match the black chip on the screen with the black chip of the 
chart in the viewing area 

• Use the White Balance Tool to white balance on a white in the scene – on the 
GretagMacbeth colour chart this was done on the white chip of the greyscale.  

 
Check that the colour space indicated at the centre of the bottom row of the display is 
ProPhoto RGB, if it is not click on it to display the Workflow Options window illustrated 
below. Click on the Space: options and select ProPhoto RGB and then OK.  A ProPhoto 
RGB profile has now been added to the raw file. 
 

 
 

Click on ‘Open Image’ to open the file in Photoshop. The options previously described in 
this section, as appropriate, are now available to the user. 
 
4.5. Image Adjustments in Photoshop 
In order to exercise colour management thoroughly we will undertake the absolute minimum 
of adjustment to the loaded reference files, limiting ourselves to only two adjustments using 
Image>Adjustments>Levels: 
 

• ‘Set White Point’ – is used to set the colour balance of the white chip of 
the chart grey scale and automatically makes it equal to level 255) 

• ‘Set Grey Point’ – is used to set the colour balance on third grey patch 
from black. 
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To set the white point, click on the ‘Set White Point’ picker and then click on the white of the 
grey scale. To colour balance any transfer characteristic grey scale irregularities click on the 
middle ‘Set Grey Point’ picker and then click on the third grey chip from zero2. That is the 
limit of any adjustment to the image. The resulting adjusted image should appear very similar 
to that illustrated below.  
 

 
 

The Adjusted Image 

                                                 
2 The grey point picker equates the red, green and blue signal levels to the level of the maximum signal at that 
level rather than preferably equating the levels to produce the same lightness level. An alternative approach 
therefore is to use the Curves to adjust for neutral on the appropriate grey scale chip. 
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4.6. Comparing on Screen and Original Images 

Comparing the display with the original image can clearly only be done when positioned in 
front of the system’s viewing area previously described. Nevertheless the results can be 
described and themselves photographed to give an indication of proof as to whether colour 
management is working. 
 

 
 

The Minolta RAW File Image 
 

This is the Minolta RAW file after adjustment in the Adobe RAW file converter as described 
previously.  The yellow chip is very slightly more towards orange than the original and 
although the other captured images also match well, by a small margin, in direct comparison, 
this is probably the best overall match of all the captured files. 
  
 

 
 

The Minolta Adobe RGB TIFF File Image 
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The illustration at the bottom of the previous page is the Minolta Adobe RGB TIFF file 
image.  The visual match of this file to the original was excellent, with a very slight increase 
in the saturation of the orange chip and a very slight increase in the lightness of the red and 
green chips. Both the sRGB and the Adobe RGB jpeg files were of a very similar appearance. 
 
However to get the scanner images to match it was necessary to first adjust the black level to 
reduce the lightness of the darker elements of the scene, also there was a slight gamma 
mismatch between original and display on the two darkest steps.  
 

 
 

The Epson Scanner Adobe RGB File Image 
 

Nevertheless the scanner images once adjusted as described produced a very good match 
between the on screen display and the original colour test chart with an almost perfect match 
of the RGB primaries, again an increase in the saturation of the orange and a slight move of 
the yellow towards orange; the latter emphasised in the illustration above over what appeared 
in the direct comparison. 

 
 

©Michael Tooms 2007/2008  Page 40 of 50 



 
 

Photo of the Original Colour Chart and its Screen Display 
 
This is an un-retouched photo of the original chart (top) with the screen showing the Minolta 
Adobe RGB TIFF image (below). Admittedly not a very scientific approach, with the result 
being open to criticisms of the effect of metermerism etc. However, together with the visual 
evaluation above, the results may be interpreted to indicate a proof that colour management at 
the display level is working well.   
 
4.7. Printing Images 
4.7.1 Review of Requirements and Facilities 
A working process has been achieved which produces a good match between the scene and 
display for in-gamut colours, attention must now be  turned to achieving good results for the 
match between the display and the print. 
 
Both because the printer and the gamut of its inks or pigments may be incapable of containing 
the gamut of the display, and the difficulty of matching the contrast law of the printer with 
that of the display, it is inevitable that the match is likely to be compromised to some degree. 
 
Although ink jet printers operate in a CMYK colour space, nevertheless they are driven by 
Photoshop with signals deriving from a LAB to RGB colour space, so the printer driver must 
undertake the conversion to the appropriate CMYK working space. 
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In order to provide as a display option, an indication of what the print will look like, i.e. a 
‘soft’ proof, Photoshop incorporates the printing profile into a profile which operates in both 
directions; i.e. it provides the parameters for best results, moving from the working space to 
the print space, but also provides a complementary profile with  parameters for converting 
derived values in the print colour space to the working colour space. Thus one is provided 
with the option of displaying the best possible result directly from the working space using 
the display profile or selecting for comparison a display based upon the output from the 
values in the print colour space which is effectively a soft proof of what one can expect from 
an actual print. 
 
Workflow - Printing 
Attention will now focus on the detail of setting up and using Photoshop to obtain a matching 
print. However before proceeding into the complexities of printing with Photoshop, it may 
help to clarify the situation by first reviewing  the appropriate elements of the workflow 
diagram. 
 
 

 
 
 
The complexity in the switching arrangements associated with printing are related to the 
ability to both view and  print a ‘proof’ of how the image would appear on a commercial 
printing press. The switch positions shown relate to the ‘normal’ viewing and desktop printing 
positions. The support of proofing enables an appropriate press profile to be utilised together 
with a profile return path to enable the appearance of the press print to be emulated 
individually on both the monitor and the desktop printer. The menu selections to enable these 
options are shown on the diagram adjacent to the switches. 
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4.7.2 The Photoshop Printing and Proofing Settings 

4.7.2.1 Printing to the Local Inkjet Printer 
To ensure colour management is carried right through the system, settings need to be set in 
both Photoshop and in the printer driver. However since both Photoshop and the printer offer 
colour management of the printer, it is important that only one of these options is activated, 
otherwise effectively a correction profile will be applied twice. Discussion with Epson 
indicates that their driver is intended for relatively simple applications, which do not have the 
sophistication of Photoshop, so in our situation we should ensure that the colour management 
facilities of the Epson printer driver are turned off. The method of achieving this will be 
described shortly. 
 
When a printer is set up in Windows, the printer driver which is loaded also includes the 
profiles for connecting the working space of Photoshop to the printer. For a relatively simple 
printer this will be one generic profile, whilst the more professionally orientated printers will 
also include a profile for each of a range of print papers.  
 
The Photoshop print screen has a different appearance between CS and CS3 versions, with the 
CS3 screen being pro-active in reminding the user to be sure that only Photoshop or the 
printer supplier is providing colour management at the print stage.  
 
The required profile may be selected in Photoshop by first displaying the ‘Print’ panel, which 
in the CS version is under the menu item ‘File>Print with Preview’ or Ctrl+P  as shown in 
this illustration. 
 

 
 
 
 
Select via menu: 
 
File> 
Print with Preview 
 

 
 
If the screen capture on the previous page is not shown then tick the ‘Show More Options’ 
box. In the lower panel which then appears, one should ensure that ‘Color Management’ is 
selected and in the ‘Source Space’ panel that the ‘Document’ option is selected. In the ‘Print 
Space’ panel under ‘Profile’ select the profile associated with the printer and paper to be 
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used. If relevant, this selection may include specific profiles purchased for particular 
printer/paper combinations. However, if for some reason, it is decided to leave colour 
management of the printer to the printer driver, then select ‘Printer Colour Management’ 
from near the top of the profile menu, which will prevent Photoshop compensating for the 
printer characteristics. Under ‘Intent’ select ‘Perceptual’ or ‘Relative Colorimetric’ as 
required and tick the Black Point Compensation box. 
 
For the CS3 version the menu selection is ‘File>Print’ and the corresponding screen capture 
is illustrated below. 
 

 
 
 
In the right hand panel which appears one should ensure that ‘Color Management’ is 
selected and in the ‘Print’ panel that the ‘Document’ option is selected. In the ‘Color 
Handling’ area, select ‘Photoshop Manages Colors’ and in the next box select the profile 
associated with the printer and paper to be used. If relevant, this selection may include 
specific profiles purchased for particular printer>paper combinations. In the above illustration 
the profile provided by FotoSpeed for the specific paper used is selected. Under ‘Rendering 
Intent’ select ‘Perceptual’ or ‘Relative Colorimetric’ as required and tick the Black Point 
Compensation box. 
 
Workflow – Printing - Setting up the Print Driver 
Select ‘Page Setup’ to access the printer driver settings and then select in order: ‘Printer’, 
and select the required printer; and ‘Properties’, when depending on the printer model, a 
screen capture similar to that below will be displayed. 
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Select the media type appropriate to that which is loaded in the printer and then in the ‘Mode’ 
panel click on the ‘Advanced’ tab. 
 
Workflow – Printing - Print Driver Colour Management – Off 
 

 
 
On the ‘Advanced’ screen, in the ‘Color Management’ panel select ‘ICM’ and tick the ‘No 
Color Adjustment’ box. Under ‘Print Quality’ use ‘Best Photo’.  
 
Select the ‘OK’ command successively until the ‘Print’ screen is active once more. The 
system is now ready to produce prints best matched to their appearance on screen, using the 
‘Print’ command. 
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4.7.2.2 Proofing 

Workflow – Printing – Proofing 
 
Both soft and hard proofing are available: 
 

• Soft Proofing 
o The option of proofing either the local inkjet printer or a selected CMYK 

printing press on the system display. 
 

• Hard Proofing 
o The ability to print, subject to the gamut of the local printer containing the 

gamut of the printing press, an emulation on the local printer of what the press 
printer would produce 

 
Proofing can be carried out on screen using the soft proof feature or, on the basis that the 
inkjet produces relatively little distortion by comparison to a printing press, the inkjet can be 
made to produce a hard proof of what the CMYK press would produce i.e. a hard print of the 
screen’s soft proof. 
 
Workflow – Printing - Proof Setup 
Setting up the proofing feature is achieved by selecting the menu item ‘View>Proof Setup’. 
The resulting list enables the selection of the printer colour space to be used as the basis of the 
proof.  
 

 

 
 
 
 
Select via menu: 
 
View> 
Proof Setup 
 

 
 
Should the desired printer not be on the list, it may be found by selecting the ‘Custom’ item 
at the top of ‘View>Proof Setup’ menu selection, when:-  
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This panel for CS3, or similar for CS, will appear. 
 

 
 
Clicking on the ‘Profile’ selection (CS) or ‘Device to Simulate’ (CS3) will bring up a range 
of press and local printers and the appropriate one may be selected. (The ‘Reset’ and the two 
‘Default’ buttons appearing on the screen capture illustration above incorrectly reflect the 
actual name of these buttons which are respectively, ‘Cancel’, ‘Load’ and ‘Save’.) 
 
The display may now be switched between the ‘normal’ display and the soft proof display by 
selecting the menu item ‘View>Proof Colors’ or more conveniently by alternating Ctrl+Y. 
This control works on the current image only and will add the name of the printer to that 
image window’s title bar to remind you that you are looking at a proof display, as can be seen 
in the screen capture illustration below. (Screen capture can emphasise the saturation of the 
image colours.) 
 

 
 

Printer Name Added to Image Window Title Bar 
 

With a good quality desktop printer as the default, as one selects the proofing option, only 
relatively minor changes in display are seen, even on this testing chart, indicating that this 
printer’s pigments are only just limited by the scene colours. If the saturation is artificially 
increased, by for example reducing the level of blacks in the scene, then the difference in the 
proof can clearly be seen; or a more forceful demonstration is to use Proof Setup to select 
‘Working CMYK’, whereupon selection of ‘Proof’ will make a more apparent change in the 
displayed image. 
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4.7.2.3  Printing to the Press Printer 
To produce a hard copy of the proof we need to return to the ‘Print’ page where the ‘Proof’ 
option should be selected. Whereupon it will be noted that the adjacent proof item description 
will be the name of the printer selected previously under ‘View>Proof Setup’.  
 

 
 
 
A print produced under this setup condition will emulate the print that would have been 
produced by, in this case, a press setup to the ‘Europe ISO Coated FOGRA27’ standard. 
 
4.7.2.4. Workflow – Printing - Gamut Warning 
Lastly, if a check needs to be done to ensure one is doing is not exceeding the gamut of a 
particular printer, selection of ‘View>Gamut Warning’ will, on the selected image, cause 
grey to be displayed on those colours in the image which are outside of the gamut of the 
printer, as the illustration at the top of the next page, using the default CMYK printer shows. 
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Screen Capture Showing the Effect of Out-of-Gamut Colours in Grey 

 
4.8. Comparing Original and Display Images with the Print 

4.8.1 Comparing the  Display and Print 
 

 
 

Comparing Print (above) with Display (Below) 
 
The illustration above is an un-retouched photograph, this time showing the print against the 
screen image of the same file. This is a surprisingly good representation of the actual visual 
match and is close enough to be reasonably confident that for this test, colour management is 
working well.  

©Michael Tooms 2007/2008  Page 49 of 50 



4.8.2 Comparing Print with Scene 
The visual match by the author between the print and the original GretagMacbeth colour chart 
was generally very good. (The author has proven good colour vision and discrimination!)  A 
critical subjective appraisal chip by chip showed an excellent greyscale, slight desaturation on 
the orange and the red, green & blue primaries, yellow had moved to a slightly greener hue 
and the purple was darker than the original. The only chip which fell below the just 
discernable level was the primary cyan which was too blue and desaturated 
 
At the presentation of this paper to the Image Science Section of the Royal Photographic 
Society in December 2007, the colour chart and the print were made available for the 
delegates to compare. All comments received were favourably inclined, some enthusiastically 
so. 
 
The illustration below is an un-retouched photograph of the GretagMacbeth colour chart 
placed adjacent to the Embedded AdobeRGB TIFF file print, produced in accordance with the 
procedure outlined in this paper. 
 

 
 

Comparison of the Print (top) with the Original (Below) 
 
In summarising, it has been shown that if care is taken with the settings of the equipment in 
the system, then it is possible without too much fuss to produce excellent prints in terms of 
properly representing the dynamic range and the colours which were present in the original 
scene. 
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